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Slidewise

by Chris Taylor

lot. I prepare presentations for

OPCUG’s main meetings and
Q&A, the Ottawa Public Li-
brary, the Orleans Photo Club,
the National Capital Freenet, and
more. | use PowerPoint most
days.

I use Microsoft PowerPoint. A

I like the extensive capabilities
and flexibility of PowerPoint.
But that can be a double-edged
sword. It is easy to end up with a
mess, especially if multiple, in-
experienced people are editing
presentation files. You can easily
end up with slide formatting
deviating from the slide master,
multiple conflicting slide mas-
ters, random colour and font
selections, and more. All can
lead to a drastically inconsistent
look and feel to your slides. You
can also have PowerPoint files
bloated with oversized graphics
and unnecessary embedded
fonts.

Frequently, I have been given
PowerPoint files created by oth-
ers that were so inconsistent and
difficult to edit that I resorted to
creating a new file and manually
transferring all the content from
the old file.

Biggest issue by far—fonts

I find inconsistent fonts are the
most egregious problems with
PowerPoint. It is far too easy to
copy text from multiple sources
and carry the font formatting into
your slides, leading to a dog’s
breakfast such as;

* Aggregate
» Aggregate
« Aggregate

The first line is Calibri and the second is Arial.
Both are sans-serif fonts but the shape of the letter
g is dramatically different and even though they
are both the same point size, they are different
heights and widths. The third line is Century—a
serif font. All these differences lead to a very jar-
ring effect when used together.

If you have slides developed on different comput-
ers, even bigger problems can occur when Win-
dows silently substitutes fonts. Consider one per-
son designing a poster and passing it on to some-
one else who will print and post the final copy
throughout your neighbourhood.
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The title used a font called Frightmare. The file
was then opened on a computer that didn’t have
Frightmare installed. Windows substituted a dif-
ferent font, resulting in a completely different
effect!

Unfortunately, even though PowerPoint is over 30
years old, Microsoft has never seen fit to add
tools to PowerPoint that would allow users to find
these problems, let alone fix them or—better
yet—prevent them in the first place.

Slidewise from Neuxpower Solutions
can ferret out these PowerPoint prob-
lems and more. It can fix inconsisten-
cies with fonts, consolidate and organ-
ize Masters, Layouts and Slides, find
non-theme colours, check hidden con-
tent, and find images bloating the file
or reducing quality.

Slidewise appears on the Home tab of
the PowerPoint ribbon. Clicking it
brings up the Slidewise panel.
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Next Meeting

Wednesday, January 10, 2024

Fraud 101: Beware of Scammers
Speaker: Cst. Sébastien Lemay (Ottawa Police Service)

Constable Sébastien Lemay from the Ottawa Police Service
will be giving a presentation on fraud. He will discuss the types
of fraud — both online and in-person — we are likely to encoun-
ter. He will provide us with tips on how to spot fraud attempts
so we can avoid becoming a victim and what to do if you fall
victim to a fraudster.

Fraud can happen to anyone. But the more you know, the less
likely you are to fall victim. Please invite others to attend this
important presentation.

Cst. Sébastien Lemay has been an officer with the Ottawa Po-
lice Service for 14 years, after serving in Wakefield, Quebec,
for 2 years. He is in his seventh year as a community police
officer for the Lower Town, Byward Market and Sandy Hill
neighbourhoods.

As a community police officer, Sébastien acts as a liaison be-
tween the community and the Ottawa Police Service. He regu-
larly follows up on problems that patrol officers might not have
been able to resolve; meets with residents and business owners
to share some crime prevention strategies; attends meetings
with resident associations, businesses and other stakeholders;
and finally, meets with different groups to offer presentations
on various safety and security topics.

This meeting will be via Zoom video conference.

Join us at https://tinyurl.com/opcug-meeting. The Zoom link
will be live at 7:15 pm. The meeting will begin at 7:30 pm.

The above link includes the meeting ID and password. Howev-
er, if you are prompted for the information, use:

Meeting ID: 924 9556 0898
Password: opcug

Coming Up...

Next Q&A session: Wednesday, December 20

February 14

Using ChatGPT to program in Python
Speaker: Tom Trottier (OPCUG)

Follow Tom as he tries to cajole ChatGPT into creating a py-
thon program to combine chat and caption transcripts together
by time. This will be Tom's first Python program.

March 13

Building a Website — No Coding Required!
Speaker: Alan German (OPCUG)

In this presentation we will see how to create a website from
scratch and make our content available on the Internet, no
HTML coding required

April 10
TBA

May 8
Free Software: What Can It Do For You?
Speaker: Adam Hunt (writer, Full Circle Magazine)

This presentation will cover some interesting free software
applications you could be using today, plus a quick look at
Linux on the desktop in 2024.

Upcoming OPL Presentations

The Fall OPL presentations by our club have all been given.
We are waiting for the OPL to accept presentations we have
submitted for January-March 2024.

Visit https://opcug.ca/opl-presentations/ for updates.

All scheduled regular monthly meetings, weekly Q&A sessions, and a link to OPCUG presentations at the OPL are
posted on our website at https.//opcug.ca/fupcoming. All events are via video conference until further notice.

CALENDAR

Meetings Date

Regular Monthly Meeting  Wednesday, January 10™
Next Q&A Session Wednesday, December 20"

Beer BOF (Wing SIG East) Wednesday, January 10"

Time and Venue

7:30 pm via Zoom video conference: https://tinyurl.com/opcug-meeting
To see all scheduled events, visit https://opcug.ca/#upcoming

Until further notice, Q&A sessions are no longer held after regular
monthly meetings. Join us on all other Wednesdays for weekly Q&A.

Enjoy a cold brew or other beverage in the comfort of your home during
the video conference.
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PRODUCT REVIEW

Backup Your Data With Duplicati

uplicati is an open-source backup program developed by Kenneth Skovhede,

a computer science professor at the Niels Bohr Institute, University of Co-

penhagen. While it was originally developed to store encrypted data in the
cloud, it functions equally well as a general-purpose backup solution using local
disk drives.

My application for this software is to create an incremental backup of the dedicated
data partition on my hard drive. Typically, I make full-disk backup images on a
monthly basis that take good care of the operating system and the installed applica-
tions since the files related to these systems change infrequently (think Patch Tues-
day!) Ialso make a manual backup of the working files on the data disk to a USB
flash drive each time I make changes to the data files. To supplement these long-
term and short-term backups, a series of incremental backups made perhaps on each
day in a given month would provide a reasonable historical record of past versions
of the data files.

Duplicati readily provides this function with the added benefit of being a cross-
platform solution, with versions available for both Windows and Linux (and also for
MacOS/OSX users on the dark side.) The program has a web-style user interface,
running in the default browser through a localhost server. It is very easy to use as it
features wizards to build the backup configuration and the restore function.
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The wizard to add a backup requires a name to be entered for the backup and, op-
tionally, a description of the nature of the backed-up files. By default, the backup
process employs 256-bit AES encryption; however, this can be turned off if encryp-
tion is not required. On the subsequent screen, a wide variety of backup destinations
is available, including cloud storage servers such as Dropbox, Google Drive, and
Microsoft OneDrive, in addition to local folders or drives. As indicated for my pur-
poses I opted to use a folder on an external USB drive as the backup target.

The location for the source data is similarly configurable, allowing selection of mul-

by Alan German

tiple drives, files and folders, with op-
tions to exclude hidden, system, or
temporary files, or files larger than a
specific size. There is also the ability
to filter out specific files and folders
based on a range of parameters, such as
“names contain” or specified regular
expressions. Backups can be scheduled
for any time of day, with timed repeats
(e.g. every hour), on any days of the
week. If any backup is missed, the job
will run as soon as possible thereafter.
The automatic backup process can also
be disabled, leaving it to the user to run
a backup process manually.

An interesting feature of Duplicati’s
backup system is that it stores blocks of
data in multiple zip files that it refers to
as volumes. There are three types of
files produced with the extensions:
.dblock.zip, for the actual blocks of
data, and .dlist.zip and .dindex.zip,
which track the block contents for sub-
sequent restoration. Building the con-
figuration allows the size of the stored
volumes to be specified. The default
value is 50 MB, chosen to avoid
timeouts when uploading to a remote
file server. Since this is not a consider-
ation for local disk storage, I opted to
increase the volume size to 1 GB which
resulted in a total of 15 files for ap-
proximately 6 GB of data. Interesting-
ly, the data compression factor is not
very high as the 15 files occupied al-
most 5 GB of disk space.

The final configuration option is the
selection of the retention period for the
backup files. By default this is set to
keep all backups. Other options in-
clude deleting backups that are older
than a specified time period, retaining a
specific number of backups, or “smart
backup retention”. The latter option
retains one backup for each of the last
seven days, each of the last four weeks,
and each of the last twelve months,
with there always being at least one
remaining backup.

I didn’t set a backup schedule as my

preference is to run the backup manual-

ly. Having completed the configura-
(Continued on page 7)
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THROUGH THE LENS

A guide to digital photography for computer enthusiasts. After the click of your camera, you're only half done!

Making a photo collage
by Lynda Buske
will be giving a demonstration at an upcoming
Q&A session on how to make a photo collage
using free Photoscape X software. I will not pro-
vide in-depth instructional details in this article but
instead hope to encourage you to think about what
sort of collages you may wish to create.

I’ve used this handy feature to commemorate all
sorts of events such as day trips, family gatherings,
births, wedding, etc. I’ve also done topic specific
collages for pets, birds and flowers. I typically have
them printed on 8x10 paper for easy framing. They
make great gifts!

While there is an automatic Collage feature in Pho-
toscape X, I find it limiting in terms of photo di-
mension and arrangement so I prefer a method
where I have more control. If you use the automatic
feature and want to print it later, please be sure to
resize the collage to your desired aspect ratio (e.g.
8x10) so it will print properly.

I prefer to start by creating a white or coloured
background. You can use any photo for this. Drag it
into the working area, crop to the desired aspect
ratio (e.g. 8x10) then go to the Insert tab, click on
the filled in rectangle, click on a corner of the im-
age and drag it down and across. This covers the
existing photo and you can now choose any colour
or pattern you wish. Save this with a name such as
Blue background 8x10.jpg. You can also add a thin
frame if you wish under the Framing tab. Once
your background is complete, make sure you are
still in Insert mode, then simply drag any photos
you want onto this background. I typically apply a
frame (or a shadow) in Editor mode using Framing/
Borders to each image before I lay them onto the
background.

There is lots of flexibility when arranging your im-
ages. You can re-size, move, overlap, and rotate
them. Once you have the pics arranged as you want,
you can add text in the size, colour and font you
desire.

If you want to display old family photos, collages
can be very useful since old snapshots often do not

have enough resolution or clarity to enlarge. With an
8x10 collage, you may have three 3x5 photos that
will look just fine in a collage as they will appear
close to their original size. With a bit of prior photo
editing within Photoscape X (contrast, sharpening,
etc.), they may actually appear nicer than the origi-
nals.

I also find a collage is a nice way to display wildlife
shots that I have taken with a less than adequate
zoom lens. I can combine smaller images where res-
olution is adequate and even tell a bit of a story if [
want.

Warning: Once you have saved your collage it
becomes a flat file and while you can add to it, you
cannot rearrange previous photos or text.

Read as PDF at https://opcug.ca/digital-photography/. Visit https://opcug.ca/opl-presentations/ to see Lynda’s OPL presentations.
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Free Membership in OPCUG!

f you are currently an OPCUG member, there is no need to pay to renew your membership for another whole year.

As has been done for several years, the Board of Directors has once again decided to waive membership renewal
fees, and this will apply to all members in good standing as of April 1, 2024. So, don’t send us any money. Your next
membership year is absolutely free.

This also means a return of our two-for-one offer for new members. Anyone pur-

chasing a new membership from now until March 31* will buy a one-year member-

ship. So, for example, a membership purchased on December 24, 2023 will provide

membership until December 24, 2024. But, because this new member will be in

good standing on April 1* (this is NOT an April Fool’s joke!) their membership will omn
automatically be renewed until December 24, 2025. Hence, two years for the price

of one! What a tremendous Christmas present for all your techie friends and rela-

tives. And, of course, anyone can buy their own new membership at any time up to March 31* and receive this same
great offer. Go to https://opcug.ca/join-or-renew/ to join our club.

Quick Tip 59: Show the full path in File Explorer’s title bar
by Chris Taylor

minor annoyance in Windows File Explorer is that the title bar only shows the current folder name rather than the full path.
In the following example, it shows 2023 rather than D:\Data\Pictures\2023.

[ = . ] . - o = | I know I can see the path below the toolbar, but it includes extrane-
ous fluff such as This PC and greater-than signs, making it harder to
read at a glance.

_ Both Windows 10 and 11 allow you to change this. Click the Start button and type Control

Oued Voow  Sesh Panel. When it appears in the Best match list, click it. Click File Explorer Options. If you are
i T RS in Category view, click A ppearance and Personalization followed by File Explorer Options.
B aarokies of s e On the View tab check the box Display the full path in title bar.
Adrced stwngs
Pk and Fokdens
Peiman syt B e gt i | = commamean x| - © *  File Explorer’s title bar will
[lﬁ""""'“' cottursas o S now show the full path rather
8 vy 1 o 1 1 o 1 than just the folder name.

Don) whow hickden S, kkdars or drives
© Show wdsen s, Yokdors anvd dves
| Bt
00 I NS S ko o Npes
B toxte tokda rresge conlicts w M2E-00-19-Onaaswr
Hicie protecied opecatng system fles (Recorwseaded|

<Chris’s latest rant> If you happened to notice the different title bar colours in the screenshots above, that is just Windows being
so consistent in handling Settings > Personalisation > Colours > Show accent colour on title bars and Windows borders. Control
Panel follows my choice for this setting. File Explorer...not so much.</Chris’s latest rant>
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Slidewise (Continued from page 1)

The Fonts section of the Fonts and Me-
dia tab will show you all the fonts that
are part of your presentation file. Dou-
ble-click any font to list the slides
where the font has been used. In the
example above, Frightmare has been
used in the title on slide 1, a rectangle
on slide 3 and the content placeholder
on slide 7. Southland is listed in orange
with a warning symbol, indicating the
font does not exist on this computer and
a different font has been substituted in
the content placeholder on slide 5 and
the title of slide 7.

You can manually clean up fonts by
going to each instance and changing the
fonts used. Or you can use Slidewise to
replace fonts on all slides by right-
clicking and choosing Replace Fonts...

v thiand e Replace Font o
Slide 5: Content P :‘_»,. h

Slide Title 1 llapse A

Choose one or more fonts to replace
and select the font to be used.

o

Select a placeholder in PowerPoint and
Slidewise will list all the fonts used in
it. Slidewise can’t show you the actual
characters using each font, which would
be a nifty addition to the program. But
it is a pretty simple operation to select
the placeholder and apply a font to all
text in the placeholder.

PowerPoint presentation files can be
bloated by embedded fonts. Slidewise
finds them and allows you to unembed
them. On the other hand, if you are
passing on a PowerPoint file and are
using fonts that are not standard Win-

dows fonts, you can use Slidewise to
embed the fonts so they will display
properly on other computers.

Slidewise has tabs for other capabilities
that can fix inconsistencies in your
presentations.

Slide Masters lists all the slide masters
and their included layouts. You can re-
assign slides from one layout to anoth-
er. If you have a real mess where multi-
ple masters and layouts have been used,
this function can help clean things up.

Colors shows where non-theme colours
have been used in your presentation. I
often use colours that are not part of the
template theme but if I get a file from
someone else where they used several
different shades of a colour, I would
probably look to standardize.

File Review lists hidden slides, com-
ments, and notes. You can have
Slidewise delete all comments or speak-
er notes from the slides, so you don’t
share information you did not intend to.

Slide Selection has two views, listing all
slides by either slide master/layout, or
transition. Each view allows you to see
at a glance how they are used through-
out the presentation. I find the transition
list particularly useful. I can see when
there are too many different transitions,
or when a wayward Fade Through
Black was chosen on one slide when all
others were set to Fade Smoothly.

Image Audit lists all images in the
presentation and flags those that have
been significantly scaled up (resulting
in poor quality) or down (candidates for
compression to save space), or have
been unevenly scaled (affecting the
aspect ratio). Slidewise gives real in-
sight into the images in your presenta-
tion, showing the sizes in KB, the actual
& displayed sizes in pixels, the scale
factors and the bits per pixel. Given
how much bloat in PowerPoint files can
be attributed to images, this is really
useful.

If you have concerns about bloated
presentation files, the Fonts and Media
tab can help tease out issues. The exam-
ple below is a 100MB PowerPoint file.
Embedded fonts take up 3 MB. Of
course, this may be required if the file is
to be passed on to others since one of
the fonts—Frightmare—is not a stand-
ard Windows font. There are 12MB of

images with one alone being 6.5 MB.
This might be worth investigating.
There is a 66MB audio file and a 20MB
video file. In some cases, it makes sense
to link to external content rather than
embedding it.

Slidewise

Preaentation 100,707 X8 ~

Slidewise has useful export capabilities.
You can export a list of the size and
number of all embedded fonts, images,
audio, and video files. You can generate
summary lists of all comments and
speaker notes. You can also have
Slidewise export all embedded images,
video, and audio.

A caution and a bug

While reassigning slides from one slide
master to another (admittedly not some-
thing you are likely to do frequently),
Slidewise made the change and auto-
matically saved the file without notice.
If you make such a change and want to
reverse it, hit Ctrl-Z or the Undo icon
on PowerPoint’s Quick Access Toolbar.

When consolidating masters, I got an
error: Sorry, an error occurved while
Slidewise was trying to perform the
action you requested. 1 got around the
problem by having Slidewise reassign
all slides using the second master to the
main master and then deleting the sec-
ond master. Neuxpower tells me this is

(Continued on next page)
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Duplicati (Continued from page 3)

tion and now back on the home screen, Dupli-
cati tells me that the Last successful backup for
my newly-created job was Never. So, to start
the backup, I click on the Run now link.

The first time the program runs it creates a full
backup of the source files and folders. Subse-

quent runs produce incremental backups and so
the process runs much faster and the additional
storage space required is considerably reduced.

As noted earlier, a second wizard is provided
when restoring data from a backup. Firstly, a
backup is identified using either the name of the
backup or its storage location, and the specific
date of interest (in the case of multiple incre-
mental backups). Next, we browse through the
directory tree to tag the files and folders to be
restored. Options for the restored files are to
place them back in the original location or to
select a new location. Existing files can be
overwritten or new files can be created with
time stamps in the file names. Duplicati han-
dles the process of identifying, locating, retriev-
ing, and storing the files recovered from the
backup zip files without any further user inter-
action.

I came across a strange (to me) occurrence
when testing the restore process. I was getting
a warning that Restore completed without errors
but no files were restored. Checking on Dupli-
cati’s user forum I found that no action is taken
to restore a file if the backup version is identical
to that in the location where the file is to be
restored. So, rather than giving this specific
explanation, the program issues the rather ge-
neric warning message.

Duplicati is simple to use, very flexible and
highly effective. In particular, the incremental
backup process is very efficient in terms of both
time and disk space required. And, additional
features, such as strong encryption of the back-
up files, are available should these be required.
Best of all, Duplicati is both free (donations
welcome), multi-platform, and open source.

So, if you are in need of a backup solution, this
software package is definitely worth a look.

Bottom Line
Duplicati (Open - DUPLICATI
Source)

Version 2.0.7.1
Kenneth Skovhede
https://www.duplicati.com

This review is available as a PDF at:
https://opcug.ca/reviews/.

Slidewise (Continued from previous page)

a PowerPoint API issue affecting some users, rather than a Slidewise bug.
The next version of Slidewise will work around the issue.

Getting to know Slidewise

Neuxpower has created a series of 17 short videos on using Slidewise that
is well worth the time for anyone new to the program:
https://www.youtube.com/playlist?
list=PLQaZjfIWUG5QqjMjRfZaaQ3cCizwMWT9a

Is Slidewise worth the price?

Slidewise is not inexpensive—the price is CA$106 per year. A 30-day free
trial version is available.

At the start of this review, I mentioned that I sometimes have to deal with
PowerPoint files so messed up that I find it easier to begin a new file and
manually transfer content to it. Slidewise would have made it far easier to
just correct the original file. In some cases, it would have saved me hours
of laborious, manual, error-prone efforts. Slidewise also helps ensure my
own PowerPoint presentation files are consistent in their look and feel.
Having used Slidewise for a few weeks, I definitely do not want to work in
PowerPoint without it.

Members of the OPCUG have been offered a 25% discount. Contact me at
Chris.Taylor@opcug.ca for details.

Bottom line:

Slidewise PowerPoint add-in
https://neuxpower.com/slidewise-powerpoint-add-in

Price: CA$106 per year

System requirements:

Windows 8.1 or greater

32-bit or 64-bit Office 2016 or greater or installed (not web) Office/
Microsoft 365

XML versions of PowerPoint data files (e.g. pptx and potx)

This review is available as a PDF at: https://opcug.ca/reviews/.

Nominations for OPCUG Board for 2024

O nce a year, the OPCUG holds elections for the 9-member Board of Di-
rectors. We are once again coming up to this annual event.

We encourage all members to consider running for a board position or get-
ting involved in some other manner in the operations of the OPCUG.

We currently have two vacant positions: Meeting Coordinator and Pub-
lic Relations. The most pressing position is Meeting Coordinator. If you
like our monthly meetings, please participate in the nomination process (you
can nominate yourself!).

If you want more information about what is involved, please contact me or
any current or past Board member. Names are listed on the back page of this
newsletter and on the web site at https://opcug.ca/executives/.

Nominations can be submitted to: nominations@opcug.ca.
Nominations must be received by midnight, December 31, 2023.

Please get involved. Help the OPCUG continue in its role of Users helping
users.
Bob Herres

Election Chair, 2024
Bob.Herres@opcug.ca
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OTTAWA PC NEWS

Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and is
published monthly except in July and August. The opinions expressed in this newsletter may
not necessarily represent the views of the club or its members.

Member participation is encouraged. If you would like to contribute an article to Ottawa PC
News, please submit it to the newsletter editor (contact info below). Deadline for submissions
is three Sundays before the next General Meeting.

To receive the monthly newsletter by email, send an email to:
opcug-newsletter+subscribe@googlegroups.com (leave subject and body fields blank)
You do not need to create a Gmail or Google Groups account.

To subscribe to other OPCUG Google Groups member services, go to:

https://opcug.ca/google-groups-how-to/

Group Meetings

OPCUG meets on the second Wednesday in the month, except July and August, at

the Riverside United Church, 3191 Riverside Drive, Ottawa. Parking is free at the
church. OCTranspo bus #90 stops nearby. Details at https://opcug.ca/venue/.
(NOTE: Until further notice, all our events are via video conference. Details at
https://opcug.ca/venue/)

Meetings are 7:30-9:00 p.m. followed by a Q&A Session until 10 p.m.

OPCUG Membership Fees:
Mailing Address:

Web address:

Follow us on Facebook:
Follow us on Twitter:

$20 per year

3 Thatcher St., Nepean, Ontario, K2G 1S6
https:/lopcug.ca
https://lwww.facebook.com/opcug
https://lwww.twitter.com/opcug

President and System Administrator

Chris Taylor chris.taylor@opcug.ca 613-727-5453

Meeting Coordinator

Vacant meetings@opcug.ca
Treasurer

Alan German alan.german@opcug.ca
Secretary

Gail Eagen gail.eagen@opcug.ca
Membership Chairman

Mark Cayer mark.cayer@opcug.ca
Newsletter

Brigitte Lord brigittelord@opcug.ca

(editor/layout/e-distribution)
Public Relations

Vacant PR@opcug.ca
Facilities

Bob Walker 613-489-2084
Webmaster

Brigitte Lord webmaster3@opcug.ca

Privacy Director
‘Wayne Houston
Special Events Coordinator
(Mr.) Jocelyn Doire

Director w/o Portfolio
Karen Wallace-Graner

privacy2@opcug.ca

jocelyn.doire@opcug.ca
karenwg@opcug.ca

© OPCUG 2024.

Reprint permission is granted* to non-profit organizations, provided credit is given to the author and
The Ottawa PC News. OPCUG requests a copy of the newsletter in which reprints appear.
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Q&A HAS GONE
ON-LINE! WEEKLY!

Because of the pandemic, the OPCUG
is holding weekly Q&A sessions in
Zoom video-conferences.

Join us every Wednesday (except on
regular monthly meeting nights) at
7:30 pm to discuss computer issues.
Questions (and answers) on any com-
puter-related issue are welcome. Or,
do you have a favourite computer pro-
gram or topic that you would like to
share with the group? Send your ques-
tions, answers, or the details of what
you would like to share to:
SuggestionBox@opcug.ca

Everyone is welcome to attend Q&A
sessions and to ask questions about
their specific computer-related prob-
lems. Join us at: https://tinyurl.com/
opcug-meeting (if you use the Zoom
client, the meeting ID is 924 9556 0898
and the password is opcug).
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